Lab Manual
Visual Studio 2008: Integrating Windows
Communication Foundation and Windows

Workflow Foundation

To build and compile this hands-on lab, you need to install:

Microsoft Visual Studio® 2008
SQL Server Express 2005
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Lab: Visual Studio 2008: Integrating WCF and WF

Note: This lab assumes a basic familiarity with Visual Studio.

With the release of Visual Studio 2008 comes new functionality that enables Windows Workflow
Foundation and Windows Communication Foundation to interoperate seamlessly together.

This lab has been built in Visual Basic, and will also serve as an introduction into some of the
language’s new features.

Lab Objective

Estimated time to complete this lab: 75 minutes

The purpose of this lab is to illustrate how WF workflows can interoperate with WCF services using
Visual Studio 2008. As we progress through this lab, we will also have an opportunity to examine new
language features in Visual Basic and productivity features in Visual Studio 2008.
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Exercise 1 — Create a Windows Communication Foundat ion Service

Contract Project

Estimated Time

5 minutes

Description

There are many ways to create WCF contracts in Visual Studio 2008; in many cases these contracts
are part of the Visual Studio project you create. While that approach is suitable for educational
purposes, it does not meet the needs of a real-world application. In a real-world scenario, you will most
likely want to share and distribute your WCF contracts to various providers without the extra overhead
of any specific Visual Studio project.

In this exercise, you will create a Class Library project that contains only the WCF contracts that we will
be working with.

Task 1 — Launch Visual Studio 2008 and create a new  Class Library Project

1. Click the Start | Programs | Microsoft Visual Studio 2008 | M icrosoft Visual Studio 2008
menu command — be sure to right-click on the choice and run as an Administrator

2. Choose File | Open | Project/Solution...
3. Navigate to the \Program Files\Microsoft\VS2008 HOLs\Lab Files\WF_W CF_HOL directory
4. Open the CHCEnterpriseLab.sIn solution located in the Start folder
5. Your solution explorer should look as shown
=

J Solution 'CHCEnterpriselabk’ (0 projects)
.. % Lab Files

----- 1&] ICreditReport.vb
. Y] IFrontOfficevb
.. Y] IPrescriptions.vb

6. Right-click on the solution node and choose Add | New Project ...

7. In the New Project dialog box select the Visual Basic | Windows | Class Library  project
8. Name this project CHCServiceContracts instead of the default name

9. This creates a basic Class Library project

10. Delete the default Classl.vb file that is added for you

11. Open the Lab Files solution folder and select all the Visual Basic files as shown
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=
J Solution 'CHCEnterpriselab’ (0 projects)
= %% Lab Files

Ij Open
Open With...
View in Browser

Browse With...

# | Cut
=3 Copy
S |

12. Select your CHCServiceContracts project node and choose Paste; this should add all the
Visual Basic source files to your new project

13. Add the following .NET references to your CHCServiceContracts project
a. System.ServiceModel
b. System.ServiceModel.Web
c. System.Runtime.Serialization

14. Build your project and verify that it built successfully

At this point you have a class library that contains all of the WCF service contracts that we will use
throughout this lab. In the real-world, if you wanted to share your contracts with someone, you would
just distribute the built DLL.

In the next exercise, we will start to use these contracts.

Exercise 2 — WF exposed as WCF

Estimated Time

20 minutes

Description

One of the additions in .NET 3.5 is the ability to expose workflows through WCF. This enables you to
expose your workflow to a number of potential callers. In this exercise, we will create a Windows
Workflow project and use one of the service contracts that we built in Exercise 1 — Create a Windows
Communication Foundation Service Contract Project to expose it through Windows Communication
Foundation.

Task 1 — Create a new Windows Workflow Project

1. Launch Visual Studio 2008 and open the CHCEnterpriseLab solution if you do not already have
it open from the previous exercise
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2. Right-click on the solution node and choose Add | New Project ...
3. In the New Project dialog box select Visual Basic | Workflow | Empty Workflow Project

=S S PR

Yisual Basic Visual Studio installed termplate:
Windows 1% Empty Workflow Project
Office 4 I_'"{_-i Sequential Workflow Library
smart Device _L'",T'-_"EState Machine Workflow Libra
Database
Test My Templates
WCF 2 Search Online Templates...
Web
Workflow -l

Yisual C#

4. Call this project CHCWorkflow
5. Right-click on the project node and choose Add | New Item...

6. Choose Workflow | Sequential Workflow (code) and name the item
PrescriptionsWorkflow.vb

. Double-click on this new file — it should open up in the Workflow designer

~

/‘i’rescriptiﬂns‘.'.‘ﬂrkﬂu-w.vh [[}E:-:ign]]

Sequential Workflow

Drop Activities to
create 3

Sequential
Workflow

Y
@

8. Select the View | Toolbox menu option
9. Notice the two new activities for .NET 3.5
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& WebServiceFault
5 While
= Windows Workflow v3.5

& Pointer

|.{§§j Receivelctivity

3 SendActivity

| = General

There are no usable controls in this group. Drag
itern onto this text to add it to the toolbox.

Receivelctivity
Version 3.5.0.0 from Microsoft Corporation

MET Component

Implements a Windows Communication Foundation

service operation.

10. Select the ReceiveActivity and drag it onto the design surface; your design surface should look

as shown

Sequential Workflow

'(?v

l"'

B receivelctivityl

Drop Activities

Here

v

11. Right-click on the project node and choose Add Reference and add a reference to your

CHCServiceContracts project

v
O]

12. Select the error icon on the Workflow designer as shown — this should open up the Properties

Window

Sequential Warkflow

9

Ll

B receivebctivityl

Activity 'receiveActivityl ' does not have a service operation specified.

L

l

13. In the Properties Window, the ServiceOperationallnfo property should be selected, press the

ellipses to edit its value
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Enabled True
FaulthMessage
OperationValidation o

ServiceOperationInfo 1 — E]

14. In the resulting Choose Operation dialog, press the Import button
15. Select the CHCServiceContracts | IPrescriptions  contract as shown and press OK

Type Mame: CHCServiceContractsIPrescriptions

Type Advanced

-4y <Current Project> Type Name & Fully Qualified Mame

-6 Referenced Assembli
5 Referenced Assemblies A Billing CHCServiceContracts.Billing

= 2" CHCServiceContracts
| il CHCServiceContracks T ICreditReport CHCServiceContractsICreditReport

-3 Systemn.ServiceModel e | [Prescriptions CHCServiceContracts.IPrescriptions

16. In the resulting dialog, ensure that the UpdatePrescriptionStatus method has been selected
and press OK, this should take you back to the Properties Window

17. In the Properties Window , select the ServiceOperationallnfo property, right-click and enable
the Commands option

OperationValidation o
PrescriptionID T}

ServiceOperation]

Status | Reset

Commands

| Description

18. In the bottom section of the Properties Window , select the Promote Bindable Properties
command; this will cause Visual Studio 2008 to execute a number of commands, you may see
the screen flickering

Generate HanB!_awf romote Bindable Properties, Bind Selected
Property..., View Receivefctivity, View Cancel Handler, View
Fault Handlers, Show activities with same cperation, Show
activities with same contract

19. Once this operation is complete, your Properties Window should look something like the
illustration shown below

20.
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P 1K

(Mame)
(ReturnValue)
CanCreatelnstance
Comments
ContextToken
Description
Enabled
FaulthMessage

PrescriptionID

Status

OperationValidation

ServiceQperationinfo

receivefctivityl
wobctivity=PrescriptionsWerkflow, P
False
3 Activity=PrescriptionsWorkflow, P
I

True
ol Activity=PrescripticnsWorkflow, P
3 Activity=PrescriptionsWorkflow, P
40 Activity=PrescriptionsWorlflow, P
CHCServiceContracts.IPrescriptic
3 Activity=PrescriptionsWerkflow, P

14. Select the entire ReceiveActivity activity in the designer and open up the Properties Window
— set the CanCreatelnstance property to True

| Properties -~ 1 X
a receiveActivityl Systern.Workflow.Activities.ReceiveActivity -
(Mame) receiveActivityl
(ReturnValue) 3 Activity=PrescriptionsWorkflow, Path=receive
CanCreatelnstance True |E|
Comments 3 Activity=PrescriptionsWorkflow, Path=receive
ContextToken
M e

At this point, we have created a workflow and exposed it as a Windows Communication Foundation
service. When that service is invoked, our workflow will start.

If you build this project now you will notice that we get a number of warnings. That is because we
specified that we will implement the IPrescriptions contract, but so far, we have only implemented the
UpdatePrescriptionStatus  method. We will only implement that single method in this lab for the
purpose of brevity, so we can safely ignore these warnings.

In the next task, we will examine the values that were passed to us when our service was invoked and
operate on them.

Task 2 — Interpret the results of the WCF input

1. In the Toolbox | Windows Workflow v3.0
surface

, select the IfElse activity and drag it onto your design
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Toolbox -1 x
= Windows Workflow v3.0

k Pointer

4 CallExternalMethod

=5' Code

_H;. Compensate

E

iE CompensatableSequence

_‘?,ij ConditionedActivityGroup

Delay

:(ftl EventDriven

E kentHandlingScope

& FauhH=ndler

‘tJ Handlé?::'\“ternalEvent

5% HfElse |
|#% InvokeWebService

2. Right click on the activity on your design surface and choose Add Branch

B ifElsehctivityl
8%
| o ‘ [Z] | View Code
ifElseBranchActivityl ifl . Document Outline
@ Generate Handlers
| Promote Bindable Properties
Drup:;:rt;vities Bind Selected Property...
v Add Branch
. | - View IfElse

3. Repeat this one more time so that you have 4 branches in total; your design surface should look
as shown
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o I

=l ifElseActivityl
| o | 0 | 0 |
ifElseBranchActivityl ifElseBranchActivity2 ifElseBranchActivity3 ifElseBranchActivityd
Drop Activities Drop Activities Drop Activities Drop Activities
Here Here Here Here
- | | s | |

v
4. Select the first branch, bring up the Properties Window and change its name to IfDispatched

5. Repeat for the other branches, naming them as follows — ElselfRequested, ElselfApproved
ElseRejected ; your design surface should look as shown

T.
| 0 | ) | 0 |
IfDispatched ElselfRequested ElselfApproved ElseRejected
Drop Activities Drop Activities Drop Activities Drop Activities
Here Here Here Here

I | TN | |

6. Select the error icon for the IfDispatched activity as shown; this will take you to the Properties
Window

| av | 0

IfDispatched Property 'Condition’ is not set. |
= =
7. The Condition property should be selected, set it to Declarative Rule Condition
(Mame) IfDispatched
Condition Declarative Rule Condition |E|
Dezcription

8. Open up the Condition node and press the ellipses beside the ConditionName property

9. Press New in the resulting dialog box
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Select Condition

Select a rule condition to be assigned to the activil
rename existing conditions.

tl New... | 7 Edit... Rename... Delete

Mame
Mew...

10. In the resulting dialog box, type Me followed by a period this will trigger the Intellisense in the
dialog box. Type the full statement shown below and press the OK button

ues I =l I
RUIE Condition Editog @lﬁ

? Edit constraints to create a rule condition.
Exarnple: this.Propl == "Yes" || this.Prop2 == 2

Condition:
me.receivelctivityl _Statusl == "Dispatched"| -

| ok || Cconcel

L. 1

11. Use the rename button to rename this rule to IsDispatched

12. Create 3 more rules with the following names and conditions as shown below and press OK to
close the conditions

a. IsApproved (me.receiveActivityl Statusl == “Approved”)
b. IsRejected (me.receiveActivityl Statusl == “Rejected”)
c. IsRequested (me.receiveActivityl Statusl == “Requested”)

13. Your Select Condition dialog should look as shown
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e - . [ [

Select a rule condition to be assigned to the activity's condition, You can also add, edit, delete or
rename existing conditions,

r."gNew... @Edit... 'f:_fgﬂename... | # Delete

Marne Valid
Approved Yes
IsDispatched Yes
IsRejected Yes
IsRequested Yes

14. Make sure your IsDispatched condition is selected, then press OK to close this dialog

15. Your IfDispatched activity should now have a condition assigned to it, so the error icon will go
away.

16. Do the same for each of your other branches — ensure that you do not assign the IsDispatched
condition to any other branch

17. From the Toolbox , select the Code item and drag it under the ElselfApproved condition;
rename it to updateStatus

At this point we are using our workflow to branch its logic based on the input that we get from the WCF
service that activates the workflow.

In the next task, we will pick one of our branches and drill into more detail. This will be an opportunity to
explore some of the new language features of Visual Basic .NET as well.
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Task 3 — Validate dispatched prescriptions

The language integrated query framework for .NET (“LINQ”) is a set of language extensions to C# and
Visual Basic and a unified programming model that extends the .NET Framework to offer integrated
guerying for objects, databases, and XML. LINQ to SQL is part of the LINQ project and allows you to
query and manipulate objects associated with database tables. It eliminates the traditional mismatch
between database tables and your application’s domain specific object model, freeing you to work with
data as objects while the framework manages retrieving and updating your objects.

Visual Studio 2008 has a LINQ to SQL designer that provides an easy way to model and visualize a
database as a LINQ to SQL object model. In this lab we will use it to create a representation of our
database.

1. Right-click on the project node and select Add New Item

2. Choose the Data | LINQ to SQL Classes item

3. Name the new item CHCData.dbml and press the OK button

4. Click on the Server Explorer link in the design surface

5. In the Server Explorer right-click and choose Add Connection...

2 [ |t . - Object Relationa
o e &b
3. &4 Servers 2] Refresh

/ Drelete
Add Connection...

Traata klas: €O Camrar Matahacs
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6. Select Microsoft SQL Server and specify the choices shown below in the resulting dialog

Data source:

Microsoft SQL Server (5glClient)

SEMVEr Name;

he o localhost\sglexpress -

"
Log on to the server

@ Use Windows Authentication

i) Use SQL Server Authentication

Save my password

Connect to a database

@ Select or enter a database name:

Refresh

CHCDatabase =

(71 Attach a database file:

7. Press the Test Connection button, you should be successful
8. Press the OK button
9. Open the CHCDatabase folder and goto Tables.

Browse...

ing 1ems

EEIgN U

10. Drag the following tables to this design surface (choose Yes if prompted by a dialog box)

a. Patients
b. Prescriptions

c. Allergies

11. Drag the following stored procedures to the command (far right) section of the designer

a. updatePrescriptionStatus

12. Your designer should look as shown
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13. Go back to your workflow designer and double click on the Code Activity , this should bring you
into the code editor

14. Go to the top of the file and add the following
PrescriptionsWorkflow.vb | 'CHCData.dbml} ™~ Prescriptions\W
J_ﬂ_,] (General)

Imports System.Linq

15. Go back to your original location and type the following (Intellisense should help you with the
type name)

Dim db As New CHCDataDatacContext()

16. Under that line, type the following (again, Intellisense will help you greatly)

Dim matchingPrescriptions = From prescriptions _
In db.Prescriptions _
Where prescriptions.ID = _
Me.receiveActivityl_PrescriptionIDl

17. Now type the following

Dim allergyCount As Integer = 0 o _ o
For Each matchingPrescription As Prescription In matchingPrescriptions

Next
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18. Inside the body of that for loop, type the following

19. Outside of the loop, finish the method by typing

20. Build your solution; it should be free of errors

21. Add code activities for each of the other branches. Double-click as before to create their
corresponding methods. For each of these code activities, simply write the line of code below:

Me.receiveActivityl ReturnValue_1 = True

At this point we have a workflow that is waiting to be activated by a WCF service. Once the
UpdatePrescriptionStatus operation has been invoked on that service, our workflow will examine the
parameters passed to it. If a prescription is being dispatched, we will see if that patient for which that
prescription was issued has any allergies. If they do, we will reject the request. Otherwise we will
approve it.

Now that we have this service and workflow, we need to host it somewhere so that clients can call it.
WCEF is very flexible in terms of how it can be hosted. WCF can be hosted in any of the following ways:

- IS
- .EXE

- Windows Service

ASP.NET web development server
- WAS (Windows Activation Service)

Exercise 3 — Hosting WCF Services

Estimated Time

15 minutes
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Description

In this lab, we will examine a number of different ways to host a WCF service; for this particular service,
we will use a regular console .EXE. This is a good choice during development because deploying and
debugging a console application is obviously very convenient.

Task 1 — Creating a console-based host

1. Right-click on the solution node and choose Add New Project ...
2. Choose a Visual Basic | Windows | Console Application
3. Name the project ConsoleHost and press OK
4. Add the following .NET references to this project
a. System.ServiceModel
b. System.Workflow.Activities
c. System.Workflow.ComponentModel
d. System.Workflow.Runtime
e. System.WorkflowServices
5. Add CHCServiceContracts and CHCWorkflow as project references as well
6. Double-click on the Modulel.vb source file
. Type the following at the top of the file to import the namespaces you need

~

8. In the Main subroutine, type the following line

9. In the next line, type the following

10. In the next line, type the following
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11. In the next line, type the following (the call to Console.Read() is particularly important)

12. Your complete subroutine should look as shown (except the endpoint should be
http://localhost:8100/Prescriptions)
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13. Build your solution; it should be free of errors. Set this project to the start project of the solution

We have a host at this point, but we won'’t execute it just yet. We will create our client first and then
execute both together.
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Exercise 4 — Creating a Client

Estimated Time

10 minutes

Description

In this exercise will create a console-based client for our workflow service.

Task 1 — Creating a console-based client

1.

Right-click on the solution node and choose Add New Project ...

a.
b.
c.
d.

e.

. Choose a Visual Basic | Windows | Console Application
. Name the project ConsoleClient and press OK

. Add the following .NET references to this project (hint, use the Recent tab in the dialog)

System.ServiceModel
System.Workflow.Activities
System.Workflow.ComponentModel
System.Workflow.Runtime

System.Workflow.Services

. Add CHCServiceContracts as a project reference
. Double-click on the Modulel.vb source file

. Type the following at the top of the file to import the namespaces you need

. In the Main subroutine type the following to setup a connection to our service (the endpoint

should be http://localhost:8100/Prescriptions)

. In the next line, type the following to invoke our operation
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10. Build your solution; it should be free of any errors

At this point we have both our host and client built; in our next exercise we will execute both to see our
WCF service and WF workflow in action.
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Exercise 5 — Host and Client

Estimated Time
5 minutes

Description

In this exercise, we will execute everything that we have built so far. The end result will be relatively
small — a record in a database will change — however, we will have exercised WF, WCF and LINQ.

Task 1 — Verifying the start state

1. From the View menu, open up Server Explorer
2. Select the Prescriptions table, right-click and choose Show Table Data

3. Verify that the first row of the table has a status of Requested — if this is not the value, you can
edit the table directly

Task 2 — Start the Host and client

1. Make sure the ConsoleHost project is the start up project in your solution

Cons

2. Select the ConsoleClient project node, right-click and choose Open Folder in Windows
Explorer
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3. Select the ConsoleClient project node, right-click and choose Open Folder in Windows
Explorer

4. In Windows Explorer , navigate into the bin | Debug folder

5. Note the path to that location and then open a Command Prompt at that location in
Administrator mode

6.

7. In Visual Studio, press F5 to start the ConsoleHost , you should see a command prompt come
up
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8. In the Command Prompt that you opened, type ConsoleClient.exe to run your client. After a
moment, it should complete

While somewhat understated — we have simulated a very complex transaction. Our host published an
endpoint that advertised it has an implementation of our IPrescriptions contract. Our client invoked an
operation on that endpoint, which in turn invoked our workflow. Since we are dispatching a prescription,
our workflow will check for allergies, and either approve or reject the request.

Task 3 — Verify Results

1. From the View menu, open up Server Explorer
2. Select the Prescriptions table, right-click and choose Show Table Data

3. Verify that the first row of the table has a status of Approved - this value was set from our
workflow; you might have to press the
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Exercise 6 — Deploying to IS 7.0

Estimated Time

10 minutes

Description

The console application host and client that we have used so far is an excellent option for debugging
Windows Communication Foundation services. It is also a good illustration of how one could host a
WCF application if one needed.

However, the most likely environment that you will use to host the WCF services that you build will be
Internet Information Server.

One of the strengths of WCF is its flexibility — WCF services can use a wide range of communication
protocols, as well as be hosted in a wide range of environments, with little or no code changes.

In this exercise, we will take the workflow that we have built — which uses WCF for activation — and host
itinlIS.

Task 1 — Creating the basic WCF web service site

1. Right-click on the solution node and choose Add New Web Site ...

2. Choose WCF Service

3. Choose HTTP as the location protocol and Visual Basic as Language
4. Set the location path as http://localhost/UpdatePrescriptionStatus :

5. Your dialog should look as shown
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6. Press OK to create the web site

The basic WCF service web site project type will create the application in 1S that we need, as well as
create a stub contract for us. Since we already have a contract and an implementation of that contract,
we will re-configure this project to use those instead.

Task 2 — Using our WCF Service

1. Add references to the CHCServiceContracts and CHCWorkflow projects
2. Right-click on the Service.svc file in the Solution Explorer and chose View Markup
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. Add a Factory attribute with the value
System.ServiceModel.Activation.WorkflowServiceHostF actory as shown below

. Change the value of the Service attribute to CHCWorkflow.Prescriptions and remove the
CodeBehind attribute completely

. Save your changes and close this file — you may see Intellisense warn you about an error that
involves an invalid character. You can safely ignore this error.

. Double-click on the web.config file in the Solution Explorer to open it

. Navigate to the <ServiceModel> configuration section and make the following changes
o Change the name of the service to CHCWorkflow. PrescriptionsWorkflow

o Change the contract to CHCServiceContracts.|Prescriptions

0 Change the wsHttpBinding to basicHttpBinding

. Close your file and save your changes

. In the Solution Explorer right-click and choose View in Browser ; IE should come up and
display a page that looks as shown
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With our service hosted in IIS, it becomes trivial to create a client for it. That is our last task of this lab.

Task 3 — Building a new client

1. From the View menu, open up Server Explorer
2. Select the Prescriptions table, right-click and choose Show Table Data

3. Change the status column value of the first row in that table to Dispatched

4.

[62]

. Right-click on the solution node and choose Add New Project ...

6. Choose a Visual Basic | Windows | Console Application
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7. Name the project NewConsoleClient and press OK
8. Right-click on the project node and choose Add Service Reference

9. In the resulting dialog, press the Discover button, select the UpdatePrescriptionStatus service,
name it ServiceReference and hit OK

10. In the Main method of the Modulel.vb file, write the following code

Dim client as new ServiceReference.PrescriptionsCli ent()
client.UpdatePrescriptionStatus(1, “Approved”, “ASA P!

11. Build the solution
12. Set the NewConsoleClient as the startup project

13. Run our new client by selecting Debug | Start Without Debugging  as shown below

14. After a moment you should see a console window that resembles

15. Press any key to close this window

16. The service we just created should be listed; press the OK button

17. From the View menu, open up Server Explorer

18. Select the Prescriptions table, right-click and choose Show Table Data

19. Verify that the first row data has changed again
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